
The Game
Options
Q & A
Screen Saver



The Game
The Basics
How To
Solo
Partners
Jokers

Options
Q & A
Screen Saver



The Game
The Basics
How To
Solo
Partners
Jokers

Options
Menus
User
Opponents
Game
Sound
Color
Keyboard Play

Q & A
Screen Saver



The Game
Options

Menus
User
Opponents
Game
Sound
Color
Keyboard Play

Q & A
Screen Saver



Question & Answer

Q. How can I register Spades?
A. It could not be simpler. You can register The Apple Tree in one of three ways. 

1) Cash, Check or Money Order
When the program first starts click on the Cash Order
button and fill out and print the order form. Mail the
order from and the amount due in the form of Cash, Check
or Money order to:

Greg DeBacker
638 San Juan Av.
Santa Cruz, CA
95065

Send US dollars or checks drawn on US banks only.

2) CompuServe's Shareware Registration Forum
If you are a member of CompuServe you can use their
Shareware Registration forum to register the software.
GO SWREG to get to the forum. Once there follow the on
screen instructions. Use ID 6808

3) Credit Card Orders
You can order with MC, Visa, Amex, or Discover from 
Public (software) Library by calling 800-242-4PsL(4775) 
or 713-524-6394. Order by FAX to 713-524-6398. You can also 
mail credit card orders to PsL at P.O.Box 35705, Houston, 
TX 77235-5705.

Order Product Number 14698

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY. THE 
AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS.

Any questions about the status of the shipment of the order, 
refunds, registration options, product details, technical 
support, volume discounts, dealer pricing, site licenses, 
non-credit card orders, etc, must be directed to:

Greg DeBacker
638 San Juan Av.
Santa Cruz, CA
95065
Internet: 71042.36@compuserve.com



To insure that you get the latest version, PsL will 
notify me the day of your order and I will ship the 
product directly to you.

Q. How much does it cost to register Spades?
A. Another excellent question. The cost of Spades is $19.50 plus $4.00 for shipping.

Q. What do I get when I register Spades?
A. You're on a roll. When you register Spades you receive the latest version of Spades along with
a free Spades Screen Saver. Not to mention the piece of mind that comes with knowing you did 
the right thing.

Also, the registered version of Spades loads much faster and does not display the logo screen in-
between games, and you get a handful of other shareware games.

Q. How many shareware games fit in a handful?
A. Oh, about 4 or 5, depending upon their size.

Q. What language is Spades written in?
A. Spades is written in *Visual Basic 3.0.

Q. I had to get a copy of VBRUN300.DLL in order to run Spades. What is this file?
A. VBRUN300.DLL is the run-time version of Visual Basic. It is needed to run all programs 
written in Visual Basic 3.0. VB stands for Visual Basic; RUN stands for run-time; 300 represents 
the version number; and DLL stands for Dynamic Link Library.

Q. I had Spades version 1.5. Do I still need the files MHRUN400.DLL and 
MHCD200.VBX?
A. No, these files are no longer needed to run Spades 2.0. However, you should make back up 
copies before you delete them in case another program needs them to run.

Q. Sometimes when I try to exit the game all I get is a beep and I can't exit. What's the 
deal?
A. When the Bidding window is showing you can't do anything, including exiting, until after you
have bid. First place your bid and then exit.

Q. I get the error message "Invalid Property Value". Please make it stop.
A. This problem is rare but when it does happen it usually has to do with the number of colors 
your video card is displaying. Try switching to 256 colors or even 16 colors and see if that helps. 
Better yet, get an update to your video driver. Contact the manufacturer of your video card for 
this.

Q. I've lost my youthful sense of optimism about the world, will playing Spades help to get 
that back?



A. Four out of five dentist agree that it will.

Q. What's up with that fifth dentist, why doesn't he agree with the other four?
A. I'm not sure but I working feverishly on this problem.

Q. I know my sound card is configured correctly because it works with other Windows 
programs, but it only works some of the time with Spades. What's wrong?
A. If Spades encounters any problems with WAV files while you are playing a game it simply 
stops trying to play them. Go to the Sound section of the Options dialog box and select each 
WAV file you are using one at time and click on Test. If there is a problem with the WAV file the 
Test button will tell you there is a problem.

Q. How can I make Spades play faster?
A. Almost every option you use while playing Spades will slow it down a bit. To make it play 
faster you can turn off the Fix Corners, Sound, Animation, Number Cards, and select Super Fast 
from the Game section of the Options dialog box.

All applications use Systems Resources (different from memory). To see how much Free 
Systems Resources you have select "About..." from the Help menu of Spades main window. At 
the bottom of the About window you will see something like the following:

Mode: Enhanced
Free Memory: 22696 kb
Free User Resources: 83%
Free GDI Resources: 59%

The last two, User and GDI Resources are the important ones here, Spades runs best if they are at
about 80% and 60%, respectively. If they are well below these values try closing any other 
applications that are currently running to free up Systems Resources. Of course, the more 
memory you have the better.

Also, the number of colors you video card is displaying can have an effect on speed. If you have 
gobs of RAM it may not matter, but if not try displaying 256 or even 16 colors to improve 
performance.

Q. How much is a "gob"?
A. When referencing RAM more than 16 megabytes constitutes a gob.

Q. Where did you get the rules for Spades? They're different than the way I play.
A. The rules for this version of Spades were taken from the book "Hoyle's Rules of Games, 
Second Revised Edition", by Albert H. Morehead and Geoffrey Mott-Smith. Library of Congress
Catalog Number: 83-61703.

The book does not mention anything about playing with Jokers. The rules that apply to Jokers are
my own.

Q. Can I get a copy of the source code for Spades?



A. No.

Q. Do the players ever "look" at each others hands?
A. No, not when bidding or playing a card.

Q. What are the files SPADES.INI and PLAYER.INF for?
A. SPADES.INI stores the option settings for all the users so that every time a user starts a game 
the same options (e.g. Card Back, Play To, Sound, ect) will be set as they were the last time they 
played. 

PLAYER.INF stores all the information about the players, both human and computer. This is 
where the Win/Loss numbers are kept, along with any custom opponents. Also, when you have 
registered, this is where registration information is kept. 

If the PLAYER.INF file becomes corrupted and needs to be deleted it will be recreated the next 
time you play. If this happens, though, you will lose all the Win/Loss numbers and you will need 
to supply your registration number the first time you play the game after it has been deleted.

Q. Where do I write to if I have comments about the game?
A. You can write to me at the same address you send your registration fee listed in the first 
question, or you can E-Mail me at:

CompuServe # 71042,36
Internet # 71042.36@compuserve.com

I encourage your comments, suggestions, and complaints. Many of the features added to this 
version of Spades were the direct result of comments I received from version 1.5.

A Last Word
Finally, although you didn't ask, I would like to thank Jay Francis and Aaron DeBacker for 
helping me to get this project off the ground. Their help in evaluating the game before its release 
was invaluable.

* Visual Basic and Windows are a trade marks of Microsoft Corporation.



The Basics
Bidding
You bid the number of tricks you think you can take in the deal. You get a bonus if you take 
exactly the number of tricks you bid. You are penalized if you take fewer tricks than you bid.

A trick consist of 4 cards, one from each player. If yours is the highest card of the 4, and is in the 
suit of the first card that was played, you win the trick. Ace is the highest and 2 is the lowest 
card. 

There are a total of 13 possible tricks in one deal. However, the total number of tricks bid by the 
4 players may add up to more or less than 13.

Trump
The suit Spades is the exception to the above rule. A Spade can beat any card except a higher 
Spade. If the other 3 players play the Ace, King, and Queen of Hearts, and you play the 2 of 
Spades you take the trick. This is called a "Trump". See Jokers for more information on 
trumping. 

When To Trump
You can only Trump with a Spade if you are out of the suit that was first played, that is, the suit 
that was "Opened" with. The suit that was "Opened" is the suit of the first card that was played, 
this is also referred to as the "Lead Suit". At the bottom, right-hand corner of the screen you will 
see an icon representing the lead suit.

You can not open with Spades until Spades have been "Broken". Spades are considered broken 
when someone trumps a trick. A status label in the bottom, right-hand corner of the screen will 
tell you when Spades have been broken. You must play in suit if you have the suit that was led.

The Flow of the Game
The eldest hand (the first player to the left of the dealer) plays first. The play goes in order to the 
left. When it is your turn to play a card you click on a card in front of you to play that card. After 
all 4 of the players have played a card the computer will determine the highest card and that 
player will be credited with the trick. The player that wins the trick will begin the next round by 
playing a card.

After all 13 tricks have been played the scores will be tallied and then the next deal will begin. 
The deal rotates to the left. This continues until someone has won the game by reaching or 
exceeding the number of points set with the Play To option.

Scoring
The following rules for scoring are based on the default settings the first time you play Spades. 



Most of the settings can be modified from the Game section of the Options dialog box.

If you take exactly the number of tricks you bid you get 10 points for every trick bid plus 20 
points for being such a good player.

If you take more tricks than you bid you get 10 points for every trick you bid plus 1 point for 
every trick over your bid.

If you take fewer tricks than you bid you get negative 10 points for every trick bid.

If you bid 0 this is called "Bidding Nil". If you Bid Nil and take 0 tricks you get 100 points. If 
you Bid Nil and take any tricks at all you get negative 100 points.

Before you look at your hand you can bid "Double Nil". The same rules for bidding Nil apply to 
Double Nil except you get 200 points if you are successful and negative 200 points if you fail.

When the Over Penalty check box is checked you will be penalized 40 points each time you take 
4 tricks more than you bid. This number is a running total for the game so you can be penalized 
more than one time in a game. Every time you reach the 4 trick limit the counter is reset to zero. 

The number of tricks you are currently over is displayed next to your name. In Partner play the 
running total is kept once for the partnership and displayed next to only one partner's name.



Playing Solo

When you play solo it is you against the three computer opponents. All bids and tricks are tallied 
separate for each player, and there will only be one winner unless there is a tie.
To switch to Partners Spades go to the "Game" section of the Options dialog box.

You can not switch from Solo play to Partner play, or vice versa, while in the middle of a game. 
If you want to switch before you finish a game you can select "End Game" from the File menu 
first.



Playing With Partners

When you play Partners there are two teams. Your partner is the player directly across from you, 
and the two players on your left and right are also a partnership.

Your bid and your partner's bid are totaled together and this constitutes the contract between the 
partners. The total bids between you and your partner are displayed next to your name, and all 
the tricks taken by the partnership are tallied next to your name. The total bids and tricks for the 
other partnership are displayed next to the player to your left.

The partners work together to fulfill the contract regardless of how many tricks an individual 
partner bid. The score for the partnership is also tallied as a single score.

The exception to this is when one or both partners bids Nil or Double Nil. When a player bids 
Nil or Double Nil his or her bid and tricks are kept separate from the partner and then the 2 
scores are totaled together at the end of the deal.

If both partners bid Double Nil there is no penalty if they both fail. Both players in a partnership 
are credited with a win if they win and both are credited with a loss if they lose.

Passing Cards
When a player bids Nil or Double Nil they are allowed to pass three cards to their partner (This 
option can be turned off. See Game Options ).

If you or your partner bids Nil your partner will lay three cards face down in the middle of the 
table and a button labeled "Pass Cards" will appear just above your hand. You must then select 
three cards to pass to your partner. You can have the computer suggest 3 cards to pass by clicking
on the Suggest button.

You select three cards by clicking on them. The color of the cards you select will become 
inverted (mostly black). Once you have selected three cards click on the "Pass Cards" button. 
The cards you've selected will then be passed to your partner and the cards your partner placed in
the middle of the table will be displayed and then added to your hand. After the cards have been 
passed the game will resume normally.

If one of the players in the other partnership bids Nil they will also pass cards between them but 
there will be no visual indication that this has happened. You can just assume that they did pass 
three cards between them.

You can not switch from Solo play to Partner play, or vice versa, while in the middle of a game. 
If you want to switch before you finish a game you can select "End Game" from the File menu 
first.



Playing With Jokers

You can chose to have Jokers added to the deck. Jokers are similar to Spades in that they can 
only be played if you are out of the suit that was led. Jokers are considered higher than Spades 
and can trump a Spade. The only card that can trump a Joker is another Joker.

There is a High and a Low joker in the deck. The High Joker can beat any card in the deck and is
designated with a capital "H" above the word "Joker" on the card. The Low Joker can only be 
beaten by the High Joker. The Low Joker is designated with a capital "L" above the word "Joker"
on the card.

If 2 Jokers are added to the deck then the deck will now have 54 cards in it. The computer will 
only deal 52 cards, and there is no way of knowing which 2 cards were not dealt. It might be 2 
high Spades or it could be the 2 and 3 of Clubs, or it could even be one or both of the Jokers that 
was not dealt.

If a player leads with a Joker the next card played will determine what the lead suit is. If Spades 
have not been broken and you or another player trumps with a Joker this does not constitute that 
Spades have been broken. Only a Spade trump can break Spades.



User Options

Access all the options by selecting "Options..." from the Options menu.

User options is where you add your name to the list of players and set a player as the current 
player. Below is a description of the User Options:

User List A list of the available users from which you can chose.
New User Name Here you can type in your name, and then click on "Add" to 

add your name to the User List.
Add Button Adds the name you typed into the New User Name text box to 

the User List.
Remove Button Removes the name displayed in the User List from the User 

List.
Set Button Sets the name displayed in the User List as the current user.

Opponent Options

Access all the options by selecting "Options..." from the Options menu.

There are 13 sets of opponents you can chose from, or you can add your own custom opponents 
to the list. To add custom opponents first select "Custom" from the 14 opponent sets. Next type 
in your 3 custom opponents in the 3 text boxes to the right of the opponent sets. After you have 
typed in your custom opponents click on the "Save" button.

Click on the "Set" button to set your selected opponents as your opponents for the current game. 
If "Randomize On Start Up" is checked the computer will randomly select a set of opponents for 
you each time you start the game.



Game Options

Access all the options by selecting "Options..." from the Options menu.

Below is a description of the Game Options available to you.

Play To - Determines how far a game is played until a winner is decided. The choices are 250 
points, 500 points, 750 points, 1000 points.

Speed - Determines how fast the cards are displayed and how long a trick remains on the table 
before it is removed. The Choices are:

Super Fast This is as fast as your computer can go.
Fast There are slight delays between cards played and when the trick is

removed.
Medium The delays are a little longer than the Fast setting.
Slow Delays are longer still and the winning card is flashed before the 

trick is removed.

Jokers - Determines how many Jokers are added to the deck.

Suit Order - Determines the order in which the suits are displayed in your hand. The choices 
are:

H-C-S-D - Hearts, Clubs, Spades, Diamonds
C-H-D-S - Clubs, Hearts, Diamonds, Spades

Play Sounds - WAV files are played on certain events when checked.

Animate Cards - The cards are animated when the trick is cleared from the table.

Number Cards - The cards in your hand are numbered to make it easier for keyboard play.

Fix Corners - Rounds off the corners of the cards. Turn off if speed is an issue.

Partners - You play with a Partner when checked. See also Solo play.

Over Penalty - When checked you will be penalized 40 points each time you take 4 tricks more 
than you bid. This number is a running total for the game so you can be penalized more than one 
time in a game. Every time you reach the 4 trick limit the counter is reset to zero. 

Show Options - The options you've selected are displayed at the top of the table when checked.

Pass On Nil - When this is checked you will be allowed to pass three cards between you and 
your partner when one of you bids Nil or Double Nil.



Scoring
Values entered for the following items will determine how the game is scored.

Exact Bid The bonus scored for getting exactly the tricks bid.
Extra Tricks The score you receive for each trick taken over your bid.
Nil Bid This value will be added to your score if successful with a Nil 

Bid or subtracted if unsuccessful.
Double Nil Bid This value will be added to your score if successful with a 

Double Nil or subtracted if unsuccessful.
Over Penalty If the Over Penalty checked box is checked this amount will be

subtracted from your score every time you meet or exceed the 
Tricks Over number.

Tricks Over The number of tricks you must meet or exceed to be penalized 
the Over Penalty amount



Sound Options

Access all the options by selecting "Options..." from the Options menu.

If you have a sound card you can attach WAV files to events in Spades. Below are a list of the 
events you can attach WAV files to:

Start Up  WAV played when the game first starts.
Spades Broken  WAV played when Spades have been broken.
Wrong Selection  WAV played when you try to play out of suit.
Set Hand  WAV played when you take fewer tricks then you bid.
Click Card  WAV played when you click on a card to play it.
Lose Game  WAV played when you lose a game.
Win Game  WAV played when you win a game.

Spades is shipped with several WAV files. However, you can chose to attach your own WAV files
to the events listed above.

To the left of the listed events in the Sound section of the Options box there is a directory and file
list box for you to find WAV files on your computer's hard drive. Once you have found the 
specific WAV file you wish to attach to an event make sure that the specific event is selected and 
then click on the "Set" button.

If you don't wish to have a WAV file attached to a particular event select that event and click on 
the "Clear" button.

You can test a WAV file by selecting it from the file list box and then clicking on the "Test" 
button. If for some reason the WAV files are not playing during the play of the game, and you 
know that your sound card is set up correctly, the "Test" button will tell you if any errors where 
encountered while it was trying to play the WAV file.

Any errors encountered playing WAV files during the play of the game will be ignored and no 
error messages will be displayed. The WAV files will simply no longer play until you have fixed 
the problem or removed the offending WAV file.



Menus

File
Start Game Starts a new game.
End Game Ends the game you are playing.
Restart Deal Restarts the current deal.
Save Game Saves the game you are playing to disk.
Save Game As Allows you to give the saved game a name.
Load Game Loads a saved game.

      Exit Exit Spades.

Options
Display Scores Displays a break down of the scores for the current game.
Review Game Allows you to review all of the tricks and scores for the 

game.
Auto Play The computer will play your hand for you.
Options Displays the Options dialog box with all the game options.

Players
Current User's Name
First Opponent's Name
Second Opponent's Name
Third Opponent's Name

By selecting an opponent from the Players Menu you can either show or hide their hand or set 
their style of play. There are 4 styles of play to chose from. Setting your own play style will not 
make you a better or worse player. It will, however, determine how well the computer does at 
suggesting cards when you click on the Suggest button.

Passive Style - The computer will attempt to go right-on their bid and will not be as aggressive at
trying to set their opponents.

Aggressive Style - The computer will try for every and all tricks and will always be trying to set 
opponents.

Beginner - Just at it sounds. You will occasionally end up scratching your head and wondering 
why the heck the computer played that card.

Experienced - The computer makes more thoughtful card selections and watches out for their 
opponents more during Partner play.

Help
Search Help Search this help file for a particular topic.
Help Contents Open this Help file.
About View the About Box for information about version number and



system's resources.
Display Logo Displays the logo screen.

Keyboard Play

You use the function keys to play Spades using the keyboard. Press key F1 to play the first card 
on the left of your hand, key F2 for the next card, F3 for the next, and so on. You use the Insert 
key to play the 13th card in your hand.

To make it easier to tell which card you are playing you can have Spades number the cards for 
you by selecting "Number Cards" from the Game Options dialog box.



Spades Screen Saver

Registered users of Spades will receive the Spades Screen Saver when they have paid their 
registration fee. 

To use the Spades Screen Saver first copy the file SPADES.SCR to your Windows directory 
(usually C:\WINDOWS). Next, start the Control Panel applette that comes with Windows and 
double-click on the Desk Top icon. From the list of screen savers chose Spades.

You can set up the Spades Screen Saver for password protection by clicking on the Set Up 
button. Even though the Spades Screen Saver is password protected you should not consider it a 
security system for your computer. It can be bypassed.

If you forget your password you can edit the CONTROL.INI file found in your Windows 
directory and delete the line that begins with "Password=".



Color Options & Card Backs

Access all the options by selecting "Options..." from the Options menu.

Color Options
You can set the colors of the main playing area to suit your preference. The color of the 
following aspects can be changed:

Card Table This is the main playing area.
Bid Label Displays the bids for each player.
Trick Label Displays the tricks taken by each player.
Bid/Trick Outline Outline color of the Bid and Trick Labels.
Player's Name Displays the 4 players name.

When you are looking at the color options dialog box you can click on one of the above aspects 
of Spades and a color selection window will open. Select a color and click on OK to change the 
color.

When you click on the Bid Label or Trick Label from the Color dialog box you will be asked if 
you want to change the font. If you say yes you will be changing the font color, if you say no you
will be changing the background color of the Bid or Trick Label.

Card Backs
Click on the Cards tab to select from the 10 different card backs available. When you click on 
one of the card backs a red box will appear around it to indicate that it is the selected card back. 
Click on the Apply button make this your selection in the game.



How To
Draw For Deal
When you start a new game a window will be displayed at the top of the card table displaying the
entire deck face down. Each player, starting with you, will draw a card from the deck. The player
who draws the highest card will be the first dealer. To draw a card from the deck click on it.

When drawing, suits and trumps don't count. If two players draw the same card, such as two 
queens, the second card will be the higher of the two.

Bidding
After you have drawn, the cards will be dealt and the bidding window will be displayed in the 
middle of the card table. Your hand will be face down. 

The bidding window will display the bids of any players who have already bid and the number of
bids that are not accounted for. Your bid is not limited to this amount.

The bidding window will ask you if you want to bid Double Nil. If you click on the Yes button 
you be asked to confirm your Double Nil bid. If you click on No your hand will be turned face 
up and the two buttons at the bottom will now read Suggest Bid and OK. 

You can click on Suggest Bid to have the computer suggest a bid for your hand or you can use 
the scroll bar in the center of the bidding window to select your bid value. When you have 
chosen your bid click on OK to accept the bid.

Playing A Card
Once you place your bid the bidding window will disappear and the game will begin. To play a 
card you click on it with the mouse. Once all the cards in your hand have been played the deal 
will be passed to the left and the bidding process will start again.

Tools And Display 
On the right of the card table is a panel that shows the statistics for the players and 4 buttons. 
Here you can view each players Win/Loss record, their style of play, and their current score.

Below are a description of the 4 buttons (See also Game options):

Sort Hand Changes the suit order of your hand.
New Game Starts a new game.
Card Back Toggles through the 4 card backs.
Suggest Clicking on Suggest will have the computer suggest a card for you 

to play. The color of the card the computer suggests will become 
inverted (mostly black). You can then play that card by clicking on 
it, or ignore the suggestion and play a different card.

More Info 
Below the 4 buttons you will see Total Bids and Deal Number. Total Bids is the total number of



bids placed by the 4 players and Deal Number is the number of Deals that have been played in 
the current game.

To the left of Total Bids and Deal Number you will see an icon representing the lead suit for the 
current trick. If no icon is displayed then it is your turn to lead. Below this will be displayed 
"Spades have been broken" when Spades have been broken in the current deal.

Keyboard Play
See Keyboard Play.



Graphical Device Interface: Used under Windows to create, track and remove graphics.



Creates, tracks, and removes windows and their properties.




